# Table of Contents

**Overview of Testing with Assistive Technology**.................................1
  Using Permissive Mode with Assistive Technology ........................................2
  How to Use Assistive Technology with Permissive Mode ........................................2

**Speech-to-Text Technology** ..........................................................4
  Configuring Speech-to-Text Applications ..........................................................5
    Dragon Naturally Speaking 15 Home or Professional Individual for Windows ..........5
  Windows Speech Recognition ...........................................................................6
  WordQ+SpeakQ ...............................................................................................6
  Read & Write (Windows) ..................................................................................7
  Mac Enhanced Dictation ...................................................................................7
  iOS Dictation ...................................................................................................7

**Predictive Text Technology** ...............................................................9
  WordQ5 ........................................................................................................9

**Alternative Computer Input Technology** ..............................................10
  Configuring PC Eye Mini with Windows Control on Student Devices .................10
  Configuring Dwell Clicker 2 ........................................................................11
  Configuring Headmouse Nano ........................................................................11
  Configuring Swifty: SW2 ..............................................................................11

**Assistive Keyboard and Mouse Input Technology** ................................12

**Screen Magnifier Technology** .............................................................13
  Configuring ZoomText and Fusion to Recognize the Secure Browser ............14
  Displaying Hidden Files in Windows ............................................................14

**Text-to-Speech** .....................................................................................15
  Installing the NeoSpeech™ Voice Pack ............................................................15
  Setting a NeoSpeech™ Voice Pack as the Default Voice ..................................16
  How the Secure Browser Selects Voice Packs ..................................................17
    Voice Pack Selection on Mobile Versions of Secure Browsers ......................17
  Text-to-Speech and Mobile Devices ...............................................................17

**Screen Reader Assistive Technology** ....................................................18
  Configuring JAWS Screen Readers on Student Computers Before Testing Begins 18
  Configuring JAWS to Recognize the Secure Browser .......................................18
Overview of Testing with Assistive Technology

This manual provides an overview of the embedded and non-embedded assistive technology tools that can be used to help students with special accessibility needs complete online tests in the Test Delivery System (TDS). It includes lists of supported devices and applications for each type of assistive technology that students may need, as well as setup instructions for the assistive technologies that require additional configuration in order to work with the TDS.

Embedded assistive technology tools include the built-in test tools in the TDS, such as the Text-to-Speech tool. These tools can be accessed without third-party software or hardware and do not require Permissive Mode to be turned on in the TDS.

Non-embedded assistive technology tools are the third-party hardware and accessibility software that students use to help them complete tests in the TDS. These tools require Permissive Mode to be turned on in the TDS and may require additional configuration steps prior to testing.

Students who use assistive technologies with a standard web browser should be able to use those same technologies with the TDS. Students should be familiar with assistive technology and accessibility features prior to testing and should have the opportunity to select, practice and use those features in instruction before test day. The best way to test compatibility with assistive technologies is to take a practice test administered through the Secure Browser with those technologies turned on. If they do not work, refer to the additional configuration instructions in this manual as required. If you still have questions about the assistive technology tools covered in this guide, please contact the Ohio Help Desk.

The basics of accessing the Practice Test Site and User Support information are available in the appendix. For additional information on the Test Delivery System, see the Test Administrator User Guide.

The guide includes the following sections:

- Speech-to-Text Technology
- Predictive Text Technology
- Alternative Computer Input Technology
- Assistive Keyboard and Mouse Input Technology
- Screen Magnifier Technology
- Text-to-Speech
- Screen Reader Assistive Technology
Using Permissive Mode with Assistive Technology

Permissive Mode is a TDS accommodation that allows students to use non-embedded assistive technology to complete tests in the Secure Browser. It must be turned on for any students testing with third-party assistive technology tools. When Permissive Mode is turned on, the Secure Browser’s security settings will be partially lowered to allow students to use tools that would otherwise be blocked. However, forbidden applications are still prohibited. Permissive Mode must be assigned to students in TIDE before they begin testing.

Permissive mode is available and turned on for all Alternate Assessment (AASCD) tests. For all other Ohio Assessments, after confirming the assistive technology works in the practice test site when administered through the Secure Browser, the district test coordinator must contact the Ohio Help Desk to request permissive mode be turned on. The request must be submitted 72 hours prior to the student testing.

Permissive Mode is available only for computers running supported desktop Windows and Mac operating systems. When using Windows 8 and above, the task bar remains on-screen throughout the test after enabling accessibility software.

When Permissive Mode is turned on, standard keyboard navigation in the Secure Browser will be disabled in order to accommodate any potential keyboard commands associated with the assistive technology the student may be using. For information about standard keyboard commands in the Secure Browser, see the Test Administrator User Guide.

How to Use Assistive Technology with Permissive Mode

Permissive Mode activates when students are approved for testing in the TDS. The student’s assistive technology should already be set up for use with the TDS when they begin testing with Permissive Mode.

1. Open the required accessibility software.
2. Open the Secure Browser. Begin the normal sign-in process up to the proctor approval step.
3. When a student is approved for testing, the Secure Browser allows the operating system’s menu and task bar to appear.
   - **Windows:** On Windows, the Secure Browser resizes, and the taskbar remains visible inside the test in its usual position. Students can press Alt+Tab to switch between the Secure Browser and accessibility applications that they are permitted to use in their test session.
   - **Mac:** On MacOS, the Secure Browser resizes, and students can view the dock in its usual position inside the test. If the dock is set to autohide, no resizing occurs, and the dock is only visible when the mouse moves toward the bottom of screen. Students can press Cmd+Tab to switch between the Secure Browser and permitted accessibility applications.
4. The student must immediately switch to the accessibility software that is already open on the computer so that it appears over the Secure Browser. The student cannot click within the Secure Browser until the accessibility software is configured.
Windows: Click the accessibility software application in the task bar.

Mac: Click the accessibility software application in the dock.

5. The student configures the accessibility software settings as needed.

6. After configuring the accessibility software settings, the student returns to the Secure Browser and continues the sign-in process. At this point, the student can no longer switch back to the accessibility software. If changes need to be made, the student must sign out and then sign in again.

Once Permissive Mode is turned off, the Secure Browser reoccupies the whole screen, and the student’s ability to use assistive technologies or switch between any other applications and the Secure Browser is suppressed.
Speech-to-Text Technology

Speech-to-text (STT) technology transcribes a student’s spoken words into text for item responses in the TDS. Students with the appropriate accommodations may use STT assistive technology while taking tests. The TDS currently supports several non-embedded STT tools.

Table 1 provides a list of third-party STT applications that can be used in the TDS. In addition to the applications listed in this table, students will need to use a headset, with microphone, while testing. Any wired headset with a 3.5 mm or USB connection should work. An external microphone can be used in place of a headset.

Table 1. Third-Party STT Applications

<table>
<thead>
<tr>
<th>Product</th>
<th>System Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dragon Naturally Speaking—Windows</td>
<td>• Windows 7 SP1, 8.1, 10; Server 2008 R2, 2012 R2</td>
</tr>
<tr>
<td></td>
<td>• Requires additional setup before use in the TDS (see configuration instructions)</td>
</tr>
<tr>
<td></td>
<td>• The TDS cannot confirm appropriate configurations are in use during testing, so students may be able to access prohibited features.</td>
</tr>
<tr>
<td>Windows built-in Speech Recognition</td>
<td>• Windows 7 SP1, 8, 8.1, 10; Server 2012 R2, 2016 R2</td>
</tr>
<tr>
<td></td>
<td>• Requires additional setup before use in the TDS (see configuration instructions)</td>
</tr>
<tr>
<td></td>
<td>• The TDS cannot confirm appropriate configurations are in use during testing, so students may be able to access prohibited features.</td>
</tr>
<tr>
<td></td>
<td>• Requires state approval to be removed from the forbidden applications list in the Secure Browser.</td>
</tr>
<tr>
<td>WordQ+SpeakQ</td>
<td>• Windows 7 SP1, 8, 10; Server 2012 R2, 2016 R2</td>
</tr>
<tr>
<td></td>
<td>• Requires additional setup before use in the TDS (see configuration instructions)</td>
</tr>
<tr>
<td></td>
<td>• Exam Mode must be enabled before students begin testing.</td>
</tr>
<tr>
<td></td>
<td>• This tool also includes a text prediction feature that cannot be disabled.</td>
</tr>
<tr>
<td></td>
<td>• This tool cannot read some math characters and table content.</td>
</tr>
</tbody>
</table>
Configuring Speech-to-Text Applications

Some applications listed in Table 1 require additional configuration to prepare for use during online testing. Necessary configurations are described below. Some applications send data to the cloud for processing by default. Where noted, this should be disabled to ensure the security of test data.

After you configure an application, AIR strongly recommends testing that application on a practice test administered through the Secure Browser prior to using it for operational testing.

**Dragon Naturally Speaking 15 Home or Professional Individual for Windows**

Necessary configurations for Dragon Naturally Speaking can be made from the Options dialog box, which is accessed from the Tools drop-down list on the Dragon bar.

From the Commands tab, uncheck the following settings:

- Enable launching from the Start Menu
- Enable launching from the desktop
- Enable E-Mail and Calendar commands
- Enable Cut shortcut commands

---

<table>
<thead>
<tr>
<th>Product</th>
<th>System Requirements</th>
<th>Additional Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ReadWrite—Windows</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Supported Versions: 12.0.45</td>
<td>• Windows 7 SP1, 8, 8.1, 10; Server 2012 R2, 2016 R2</td>
<td>• Exam Mode must be enabled before students begin testing (this mode is not available on Read&amp;Write for Mac).</td>
</tr>
<tr>
<td><strong>Mac built-in Enhanced Dictation</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Supported Versions: 8.0</td>
<td>• Mac 10.9–10.15</td>
<td>• Requires additional setup before use in the TDS (see configuration instructions)</td>
</tr>
<tr>
<td><strong>iOS built-in Dictation</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Supported Versions: iOS 11.4, 12.2</td>
<td>• iOS 11.4, 12.2</td>
<td>• Cannot be used with the Secure Browser.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Students must dictate into a secondary iPad set in Airplane Mode and the proctor enters the student’s response into testing device.</td>
</tr>
</tbody>
</table>
From the Miscellaneous tab, uncheck Use Dictation Box for unsupported application.

From the Scheduled Tasks tab in Administrative Settings, uncheck Enable scheduled Data Collection.

Windows Speech Recognition

Prior to testing day, the Windows built-in Speech Recognition application must be set up on each testing device that will be used by students who require STT. The application can be set up through the Windows Control Panel. To prevent Windows from sending data to the cloud, go to Start > Settings > Privacy > Diagnostics & Feedback and mark the Basic radio button in the Diagnostic Data section. Then select the Speech tab and set the Online Speech Recognition toggle to Off. During setup, Speech Recognition Voice Training must be completed by the student for optimal performance.

WordQ+SpeakQ

To minimize security risks, WordQ+SpeakQ includes an Exam Mode feature, which can be enabled through the application’s settings. Exam Mode requires a time limit of 1–12 hours to be set. Please note, this does not eliminate all security risks and once exam mode has been set, it cannot be disabled until the configured time has run out.
To turn on exam mode, click the **Options** icon, and select **Exam Mode**. In the dialog pop-up window that appears, you can allow and restrict the **Word usage examples** and **Single words added by the user** including **topic words** features. You can also set the Exam Mode time limit at the bottom of the window.

**Read & Write (Windows)**

Read & Write has an exam mode that can be used to turn off features for a single student on their testing device. When exam mode is enabled, the student will have access to only the selected features on the toolbar and certain speech settings, including voice selection, speed, pitch and **Speak As I Type** (the full settings menu will not be accessible).

To use exam mode run Read & Write and click on the settings button in the upper-right corner and then click **Show more settings**. In the **Find a Setting** field, type **adminsettings**. You will be asked to enter and confirm a password to grant access on this computer. When logged into administrator settings, click the **Select your features** tab and select which features you’d like to be enabled on the student’s toolbar. Enable the **Use Exam Mode now** toggle to start exam mode, then close the Read & Write menu to start the exam.

**Mac Enhanced Dictation**

Mac workstations that will be used for dictation should be opted out of Apple’s Diagnostic and Usage program so that no secure test data is stored on the device for analysis. Macs can be opted out of this program by disabling Analytics through the Mac’s security and privacy settings.

When you enable Enhanced Dictation on a testing device, you also must enable a language and keyboard shortcut through the device’s keyboard settings. Once Enhanced Dictation is enabled, the device must be connected to the Internet to download the offline models that allow speech to be transcribed without sending it to the cloud for processing.

**iOS Dictation**

Due to the way iPads are secured for high stakes assessments, there is currently no third-party application that can provide STT. However, students who need STT can dictate into the built-in dictation application on a secondary iPad and a proctor or test administrator can then enter the student’s response verbatim into the testing device following transcribing procedures.

The secondary iPad must be a 5th or 6th Generation iPad or iPad Pro running at least iOS 9. It must be placed in Airplane Mode so that no secure test data is transmitted to the cloud for processing. Also, it must be opted out of Apple’s Diagnostic and Usage program so that no secure test data is stored on the device for analysis.

Dictation can be enabled through the iPad’s keyboard settings. Airplane Mode can be enabled through the iPad’s main settings. iPads can be opted out of Apple’s Diagnostic and Usage program by disabling Analytics through the iPad’s privacy settings.

Prior to testing day, the secondary iPad must be connected to the Internet once to download the offline models that allow speech to be transcribed offline. This is done automatically once dictation is enabled and the device is connected to the Internet. No manual download is necessary. After the device is connected to the Internet once, AIR recommends users test offline dictation by enabling Airplane Mode and dictating into the Notes app or another similar app on the iPad. If it works, you are ready for testing.
day. If it does not work, disable Airplane Mode and reconnect the iPad to the Internet to finish downloading the offline STT models.

On testing day, enable Airplane Mode on the secondary iPad and allow the student to dictate their responses into it. A proctor or test administrator must then enter the responses verbatim into the student’s testing device following guidelines in Ohio’s Accessibility Manual.

After testing is completed, be sure to delete any secure test data on the secondary iPad; failure to do so is a security violation.
Predictive Text Technology

Predictive text technology suggests words to students as they type responses for test items. The TDS does not include any embedded predictive text tools, but it supports several third-party tools that use predictive text technology.

Table 2 provides the technology requirements for students testing with predictive text technology.

<table>
<thead>
<tr>
<th>Product</th>
<th>System Requirements</th>
<th>Additional Details</th>
</tr>
</thead>
</table>
| Co:Writer Universal (Windows & OSX) | • Windows 7 SP1, 8, 8.1, 10; Server 2012 R2, 2016 R2  
  • Mac 10.9–10.15 | • The TDS cannot confirm appropriate configurations are in use during exam, so students may be able to access prohibited features.  
  • Includes text prediction features  
  • Requires users to enter numbers from an on-screen keypad.  
  • The OSX version cannot be opened or minimized with keyboard commands. |
| WordQ5                | • Windows 7 SP1, 8, 8.1, 10; Server 2012 R2, 2016 R2  
  • Mac 10.9–10.15 | • Requires additional setup before use in the TDS (see configuration information)  
  • Exam Mode must be enabled before students begin testing. |
| Read&Write for Mac    | • Mac 10.10–10.14                                        | • The TDS cannot confirm appropriate configurations are in use during exam, so students may be able to access prohibited features. |

WordQ5

To minimize security risks, WordQ includes an Exam Mode feature, which can be enabled through the application’s settings. Exam mode requires a time limit of 1–12 hours to be set. Please note, this does not eliminate all security risks and once exam mode has been set, it cannot be disabled until the configured time has run out.

To turn on exam mode, click the Options icon, and select Exam Mode. In the dialog pop-up window that appears, you can allow and restrict the Word usage examples and Single words added by the user including topic words features. You can also set the exam mode time limit at the bottom of the window.
Alternative Computer Input Technology

Alternative Computer Input (ACI) assistive tools allow students with physical impairments to interact with a computer without using a traditional mouse and keyboard. For instance, ACI technology such as PCEye Mini tracks students’ eye movement, while Dwell Clicker 2 allows students to use a mouse without having to click the left or right mouse buttons.

The TDS does not include any embedded alternative computer input tools, but it supports several third-party alternative computer input technologies.

Table 3 provides a list of third-party ACI devices that can be used in the TDS. Please note that this list includes only the devices that AIR has thoroughly tested against the Secure Browser, but there may be additional supported ACI devices that have not been tested yet. If your students need to use an ACI device not listed here, please test it out in a practice test administered through the secure browser first to ensure it performs as expected.

Table 3. Third-Party ACI Devices

<table>
<thead>
<tr>
<th>Product</th>
<th>System Requirements</th>
<th>Additional Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCEye Mini with Windows Control</td>
<td>• Windows 7 SP1, 8.1, 10</td>
<td>• Requires additional setup before use in the TDS (see configuration instructions)</td>
</tr>
<tr>
<td>Dwell Clicker 2</td>
<td>• Windows 7 SP1, 8, 10; Server 2012 R2, 2016 R2</td>
<td>• Requires additional setup before use in the TDS (see configuration instructions)</td>
</tr>
<tr>
<td>Headmouse Nano</td>
<td>• Windows 7 SP1, 8, 8.1, 10; Server 2012 R2, 2016 R2</td>
<td>• Requires additional setup before use in the TDS (see configuration instructions)</td>
</tr>
<tr>
<td></td>
<td>• Mac 10.9–10.15</td>
<td>ibel</td>
</tr>
<tr>
<td>Access Switch</td>
<td>• Windows 7 SP1, 8, 8.1, 10; Server 2012 R2, 2016 R2</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>• Mac 10.9–10.15</td>
<td>ibel</td>
</tr>
<tr>
<td>Swifty</td>
<td>• Windows 7 SP1, 8, 8.1, 10; Server 2012 R2, 2016 R2</td>
<td>• Requires additional setup before use in the TDS (see configuration instructions)</td>
</tr>
<tr>
<td></td>
<td>• Mac 10.9–10.15</td>
<td>ibel</td>
</tr>
</tbody>
</table>

Configuring PC Eye Mini with Windows Control on Student Devices

To configure the PC Eye Mini, it should be plugged in to a computer that uses Windows Control software and should be installed by following the product’s installation instructions manually.

For students using PC Eye Mini with Windows Control Software, the Word Prediction feature should be disabled by opening the application and navigating to Settings > Keyboard.
Configuring Dwell Clicker 2

To configure Dwell Clicker 2 settings, open the application and select the keyboard icon, then click the Options key. In the window that pops up, make sure the Use Text Prediction checkbox is not checked.

Configuring Headmouse Nano

To configure Headmouse Nano when using the SofType keyboard, open the SofType application and select View > Word Bar from the menu. Then make sure the Prediction radio button is not marked.

Configuring Swifty: SW2

To configure Swifty Switch Access according to the student’s needs, the following DIP Switches should be set when using Switch. After you modify DIP Switch settings, unplug and re-plug Swifty to activate the settings.

<table>
<thead>
<tr>
<th>Switch 1</th>
<th>Switch 2</th>
<th>USB Device</th>
<th>Interface Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>ON</td>
<td>ON</td>
<td>Mouse</td>
<td>Left, Right, Middle</td>
</tr>
<tr>
<td>OFF</td>
<td>ON</td>
<td>Joystick</td>
<td>Btn1, Btn2, Btn3</td>
</tr>
<tr>
<td>ON</td>
<td>OFF</td>
<td>Keyboard (For iPad)</td>
<td>Enter, Space, Tab</td>
</tr>
<tr>
<td>ON</td>
<td>OFF</td>
<td>Keyboard</td>
<td>1,2,3</td>
</tr>
</tbody>
</table>
Assistive Keyboard and Mouse Input Technology

Assistive Keyboard and Mouse Input tools provide additional support to students with physical impairments who need to use a keyboard and mouse in order to respond to test items. These include keyboards with larger keys, computer mice with trackballs, and other tools that make it easier for students with limited mobility to use a computer.

The TDS does not include any embedded assistive keyboard and mouse input tools, as these tools typically involve the use of special hardware, but the TDS does support several third-party assistive keyboard and mouse input tools.

Table 4 provides a list of third-party assistive keyboard and mouse input tools that can be used in the TDS. Please note that this list includes only the devices that AIR has thoroughly tested against the Secure Browser, but there may be additional supported assistive keyboards and mouse input tools that have not been tested yet. If your students need to use input technology not listed here, please test it out in a practice test administered through the secure browser first to ensure there are no issues with it.

<table>
<thead>
<tr>
<th>Product</th>
<th>System Requirements</th>
<th>Additional Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keys-U-See Keyboard</td>
<td>• Windows 7 SP1, 8, 10; Server 2012 R2, 2016 R2</td>
<td>N/A</td>
</tr>
<tr>
<td>BigKeys Keyboard</td>
<td>• Supported Versions: Plus, XL</td>
<td>N/A</td>
</tr>
<tr>
<td>BigTrack2 Trackball</td>
<td>• Windows 7 SP1, 8, 8.1, 10; Server 2012 R2, 2016 R2</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>• Mac 10.9–10.15</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Windows 7 SP1, 8, 8.1, 10; Server 2012 R2, 2016 R2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Mac 10.9–10.15</td>
<td></td>
</tr>
</tbody>
</table>
Screen Magnifier Technology

Screen magnifier technology enlarges the content displayed on the computer screen to assist students with visual impairments. Although the TDS supports some non-embedded screen magnifier tools from third parties, AIR strongly recommends students use the embedded zoom tools in the TDS. These embedded tools were designed to magnify test content in the most intuitive and user-friendly manner for students.

The embedded zoom tools in the Secure Browser allow students to magnify test content to the following levels:

1X
1.5X
1.75X
2.5X
3X

Table 5 provides a list of third-party screen magnifier tools that can be used in the TDS. The non-embedded screen magnifier tools listed below come with an increased risk of interoperability issues, require students to manually pan the magnification tool across the screen, and can include unwanted features that should not be used while testing.

<table>
<thead>
<tr>
<th>Product</th>
<th>System Requirements</th>
<th>Additional Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ZoomText Magnifier (with optional text-to-speech)</strong></td>
<td>• Windows 7 SP1, 8.1, 10; 2012 R2, 2016 R2</td>
<td>• Requires additional setup before use with the TDS (see configuration instructions).</td>
</tr>
<tr>
<td>• Supported Versions: 2019.1904.80</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Fusion Professional (combines JAWS screen reader with zoom text)</strong></td>
<td>• Windows 7 SP1, 8.1, 10; 2012 R2, 2016 R2</td>
<td>• Requires additional setup before use with the TDS (see configuration instructions for JAWS).</td>
</tr>
<tr>
<td>• Supported Versions: 2019</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Magic Magnifier (with optional text-to-speech)</strong></td>
<td>• Windows 7 SP1, 8.1, 10; 2012 R2, 2016 R2</td>
<td>• The TDS cannot confirm appropriate configurations are in use during exam, so students may be able to access prohibited features.</td>
</tr>
<tr>
<td>• Supported Versions: 14.0.1512</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Configuring ZoomText and Fusion to Recognize the Secure Browser

For ZoomText or Fusion to function properly with the Secure Browser, you must perform the following steps. You must make sure ZoomText or Fusion is closed before performing these steps. You also must make sure hidden files are displayed on your computer.

1. Navigate to the folder where ZoomText or Fusion is installed on your computer: Local Disk (C:) > ProgramData > Freedom Scientific > ZoomText > [Your ZoomText version]

2. Open the ZoomTextConfig file in Notepad.

3. Locate the line that includes the text D2DPatch.

4. On the same line, type "~OHSecureBrowser", immediately after "firefox", (be sure to include the tilde and comma).

5. Save and close the file.

Displaying Hidden Files in Windows

If hidden files are not displayed on your Windows device, you should follow the steps below before configuring ZoomText and Fusion to recognize the Secure Browser.

Displaying Hidden Files in Windows 7

1. Select the Start button, then select Control Panel > Appearance and Personalization.

2. Select Folder Options, then select the View tab.

3. Under Advanced Settings, select Show hidden files, folders, and drives, and then click OK.

Displaying Hidden Files in Windows 8.1

1. Swipe in from the right edge of the screen, then select Search (or if you’re using a mouse, point to the upper-right corner of the screen, move the mouse pointer down, and then select Search).

2. Type folder in the search box, then select Folder Options from the search results.

3. Select the View tab.

4. Under Advanced Settings, select Show hidden files, folders, and drives, and then click OK.

Displaying Hidden Files in Windows 10

1. Open File Explorer and select the View tab.

2. In the Show/Hide section, mark the Hidden Items checkbox.
Text-to-Speech

Text-to-Speech (TTS) tools read aloud text that appears on the screen for students who are unable to access printed text. TTS is also required for the alternate assessment. The TDS includes embedded TTS tools that can be used by students with this setting enabled, which if not on by default for a certain test, can be done either in TIDE or from the TA Interface. In order for students to test with TTS tools, a supported voice pack will need to be installed on their device before testing begins. Students testing with TTS should also have a supported headset or headphones if not testing in a one-on-one setting.

TTS is available on all operating systems supported by the TDS (for a full list of supported operating systems, see the Quick Guide for Setting up Your Online Testing Technology). However, text-to-speech tracking does not function correctly on Linux OS. If students require the use of text-to-speech tracking, they must use a different operating system than Linux OS.

Table 6 lists the voice packs supported for students testing with TTS. If students need to use a voice pack not listed in this table, you should test it out in a practice test administered with the secure browser or secure test app to ensure there are no issues. Students can verify that text-to-speech works on their computers by logging in to a practice test session and selecting a test for which text-to-speech is available.

<table>
<thead>
<tr>
<th>Technology Type</th>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported Voice Packs</td>
<td>• Windows built-in voice packs</td>
</tr>
<tr>
<td></td>
<td>• Mac built-in voice packs</td>
</tr>
<tr>
<td></td>
<td>• iOS built-in voice packs</td>
</tr>
<tr>
<td></td>
<td>• Android built-in voice packs</td>
</tr>
<tr>
<td></td>
<td>• Chromebook built-in voice packs</td>
</tr>
<tr>
<td></td>
<td>• NeoSpeech™ Julie voice pack (available through May 2020 for download in TIDE)</td>
</tr>
<tr>
<td></td>
<td>• NeoSpeech™ Violeta voice pack (available through May 2020 for download in TIDE)</td>
</tr>
</tbody>
</table>

Note: AIR strongly encourages schools to test the text-to-speech settings in a supported Secure Browser before students take operational tests. You can check these settings through the diagnostic page. From the student practice test login screen, click the Run Diagnostics link, and then click the Text-to-Speech Check button.

Installing the NeoSpeech™ Voice Pack

If students do not wish to use the built-in voice packs on their Windows devices, you can download the Neospeech™ voice packs to their testing device. Due to licensing restrictions, students must not use these voice packs outside of the TDS. IMPORTANT: The Julie and Violeta voice pack licenses expire in May 2020 and will no longer function after this date.

1. In the TIDE banner, click General Resources and then click Download Voice Pack.
2. Download the Julie or Violeta voice pack. Save it to your computer, but don’t open or run it.

3. Navigate to the file you downloaded, which has a name similar to the following:
   - Julie: 20120224_VT-SAPI5_Julie_M16_570_win_v3.11.3.1.zip
   - Violeta: 20120224_VT-SAPI5_Violeta_M16_700_win_v3.11.3.0.zip

4. Extract the zip file into a temporary folder. Open this folder, locate the file setup.exe, and run it. If you don’t see a file setup.exe, look for a file with a blue icon 📥. (The file may be in a subfolder.)

5. Follow the steps in the installation wizard that appears. If you change the default installation directory, make a note of it.

6. Returning to the folder you created in step 4, locate the file verification.txt. (The file may be in a subfolder.)

7. Referring to Table 7, copy the file verification.txt to the folder appropriate for your version of Windows. If you used a folder in step 5 different from the default, use that path instead.

<table>
<thead>
<tr>
<th>Windows Version</th>
<th>Folder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Julie 32-bit Windows</td>
<td>C:\Program Files\VW\VT\Julie\M16-SAPI5\data-common\verify\</td>
</tr>
<tr>
<td>Julie 64-bit Windows</td>
<td>C:\Program Files (x86)\VW\VT\Julie\M16-SAPI5\data-common\verify\</td>
</tr>
<tr>
<td>Violeta 32-bit Windows</td>
<td>C:\Program Files\VW\VT\Violeta\M16-SAPI5\data-common\verify\</td>
</tr>
<tr>
<td>Violeta 64-bit Windows</td>
<td>C:\Program Files (x86)\VW\VT\Violeta\M16-SAPI5\data-common\verify\</td>
</tr>
</tbody>
</table>

**Setting a NeoSpeech™ Voice Pack as the Default Voice**

This procedure sets the NeoSpeech™ voice pack as the default. The steps in this procedure may be different for your version of Windows.

1. If you are running the 64-bit version of Windows, do the following (otherwise skip to step 2):
   a. In the Windows Explorer, navigate to C:\Windows\SysWOW64\Speech\SpeechUX
   b. Double-click the file sapi.cpl
   c. Skip to step 3.

2. If you are running the 32-bit version of Windows, do the following:
a. Open the Control Panel

b. From the View by drop-down list, select Small icons.

c. Open Speech Recognition and click Text to Speech.

3. From the Voice selection drop-down list, select VW Julie or VW Violeta. Then click Apply.

4. Click Preview Voice to listen to the audio sample.

5. Make adjustments to the Voice speed or other options as desired and click OK.

6. Test the voice pack by opening a practice or training test in the Secure Browser.

How the Secure Browser Selects Voice Packs

This section describes how AIR’s Secure Browsers select which voice pack to use.

Voice Pack Selection on Mobile Versions of Secure Browsers

The Mobile Secure Browser uses either the device’s native voice pack or a voice pack embedded in the Secure Browser. Additional voice packs downloaded to a mobile device are not recognized by the Mobile Secure Browser.

Text-to-Speech and Mobile Devices

Text-to-speech (TTS) in Windows, Mac, and iPads includes a feature that allows students to pause and then resume TTS in the middle of a passage. On Chromebooks, however, students should highlight the desired text to be read as the pause feature does not allow students to pause and resume the reading again.
Screen Reader Assistive Technology

Table 8 provides a list of supported screen reader software that students can use in the TDS.

<table>
<thead>
<tr>
<th>Screen Reader</th>
<th>System Requirements</th>
<th>Additional Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>JAWS—Professional</strong></td>
<td>• Operating Systems: Windows 7 SP1, 8, 8.1, 10</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Minimum Requirements: 1.5 GHz Processor, 2 GB RAM (for 32-bit), 4 GB RAM (for 64-bit)</td>
<td>• Requires additional setup before use with the TDS (see configuration instructions)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Screen Reader Mode student setting must be set to On.</td>
</tr>
<tr>
<td><strong>Fusion Professional</strong></td>
<td>• Operating Systems: Windows 7 SP1, 8, 8.1, 10</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Minimum Requirements: 2.0 GHz i3 dual core processor, 4 GB RAM</td>
<td>• Requires additional setup before use with the TDS (see configuration instructions for JAWS)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Screen Reader Mode student setting must be set to On.</td>
</tr>
<tr>
<td><strong>Windows Narrator</strong></td>
<td>• Windows 10</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Configuring JAWS Screen Readers on Student Computers Before Testing Begins

This section includes instructions for the additional JAWS configuration steps that technology coordinators must follow before students use JAWS for online testing. Optional voice adjustments in JAWS can also be made from the Options>Voices>Voice Adjustment window in JAWS. To ensure JAWS is properly configured, students should take practice tests administered with the Secure Browser and using JAWS before taking operational tests.

The configuration instructions in this section apply to JAWS 18, JAWS 2018, and JAWS 2019 as well as Fusion Professional.

Configuring JAWS to Recognize the Secure Browser

You must edit the JAWS configuration file so that the software recognizes the Secure Browser. The examples below are for JAWS 2018 installed to the default location. If your version is installed to a different location, navigate to the appropriate directory.

1. To modify the configuration file, open the JAWS ConfigNames.ini file. This file may appear in two folders. Depending on how JAWS is installed on your computer, you may need to modify both files:
   - Required: Start > All Programs > JAWS 2018 > Explore JAWS > Explore Shared Settings
   - Optional: Start > All Programs > JAWS 2018 > Explore JAWS > Explore My Settings
2. In the ConfigNames.ini file, locate the line of text containing `firefox:3=firefox`. At the end of this line, press **Enter** and type `OHSecureBrowser=Firefox`

3. Save the file.
   
a. If you receive an error that you do not have permission to save the .ini file to this location, save the file to your desktop as ConfigNames.ini. Then copy the updated .ini file to the folder containing the original .ini file referenced in step 1.

### Configuring JAWS to Speak “Dollars”

If a test includes content with the dollar symbol ($), you should configure JAWS to correctly speak this symbol.

1. Open JAWS and go to **Utilities > Settings Center**. The **Settings Center** window opens.

2. In the **Search for settings** panel on the left, expand the **Text Processing** settings and **Number And Date Processing** sub-settings. Click **Speak Dollars**. The **Settings Center** window displays the **Number And Date Processing** options (see Figure 4).

![Figure 4. Number and Date Processing](image)

3. Mark the **Speak Dollars** checkbox.

4. Click **Apply**, and then click **OK**.
Optional JAWS Voice Adjustment Settings

Prior to launching the Secure Browser, you can adjust JAWS voice settings for students based on their individual needs. You must set the Voice Profile, Speaking Rate, and Punctuation settings prior to administering assessments. Students should take practice tests using JAWS and administered with the Secure Browser so they can determine whether these settings need to be adjusted.

1. To adjust JAWS voice settings, open JAWS and go to Options > Voices > Voice Adjustment. The Voice Adjustment window opens (see Figure 5).

2. To adjust the voice profile, in the Profile section, select a voice profile from the Profile Name drop-down list. Click Apply.

3. To adjust the voice rate, in the Voice section, drag the Rate slider to the desired rate speed (the lower the rate, the slower the words are read aloud). Click Apply.

4. To adjust the punctuation, click the Punctuation drop-down list. Select from the following options: None, Some, Most, or All. Click Apply.

5. When all settings are saved, click OK.

Figure 5. JAWS Voice Adjustment

Administrating Screen Reader Tests

This section explains how TAs set up the test settings for screen reader. It also provides information about how students navigate the Secure Browser with JAWS.

Setting Up Screen Reader Test Sessions

TAs must make sure that students have the correct test settings applied before approving them to take screen reader tests.

For more detailed instructions about starting test sessions, see the Test Administrator User Guide.

1. To administer screen reader tests, the test administrator logs in to the TA Interface and starts a test session.

2. The test administrator opens JAWS on the student testing devices.

3. The test administrator opens the Secure Browser on the student testing devices.

4. Students sign in to the test session and select their tests.

5. The test administrator reviews the student’s test settings and verifies the following:
Screen Reader Assistive Technology

- **Screen Reader Mode** is set to On. This will arrange test content vertically and with extra whitespace.

- **Permissive Mode** is turned on. This setting must be enabled in order for students to use the keyboard commands associated with JAWS.

6. When all the correct settings are applied, the test administrator approves students for testing.

**Navigating the Student Testing Site with JAWS**

JAWS allows students to use keyboard commands to navigate the Student Testing Site.

The actions associated with each JAWS keyboard command depend on the context in which the students presses the key. In other words, the same key may have different effects depending on whether the student is on the Sign-In pages, the test pages, or within the items and stimuli of the test pages.

Table 9 provides an overview of how to use JAWS keyboard commands in each context. In order for students to use these keyboard commands, Permissive Mode must be enabled for them in the TDS. If JAWS enters Forms Mode, these keyboard commands may not work. In order to exit Forms Mode, press **NUM PAD PLUS**.

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Navigating the Sign-In Pages with JAWS Keyboard Commands</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Insert + F10</strong></td>
<td>Returns the focus to the Secure Browser if the student navigates to the JAWS application window while signing in.</td>
</tr>
<tr>
<td>(standard keyboard)</td>
<td></td>
</tr>
<tr>
<td><strong>Tab</strong></td>
<td>Moves the focus to the next field or button on the page</td>
</tr>
<tr>
<td><strong>Shift + Tab</strong></td>
<td>Moves the focus to the previous field or button on the page</td>
</tr>
<tr>
<td><strong>Down Arrow</strong></td>
<td>Reads the next line on the page</td>
</tr>
<tr>
<td><strong>Up Arrow</strong></td>
<td>Reads the previous line on the page</td>
</tr>
<tr>
<td><strong>Enter</strong></td>
<td>Selects the button that is currently in focus</td>
</tr>
</tbody>
</table>

Table 9. Overview of JAWS Keyboard Commands in the Student Testing Site
Navigating Test Pages with JAWS Keyboard Commands

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
</table>
| R   | Navigates to the next landmark region on the test page. A test page has up to three primary landmark regions:  
  • **Banner Region**: The banner contains the test information row. This row displays the current question number, test name, student name, test settings button, pause button, and help button.  
  • **Navigation and Test Tools Region**: This region displays the navigation and tool buttons.  
  • **Test Content Region**: This region consists of the *Stimulus* section and the *Question* section:  
    o *Stimulus Section*: Contains the stimulus title, stimulus context menu, and stimulus content.  
    o *Question Section*: Contains a question number, question labels (labels that appear when you mark an item for review, print an item, or enter a note for an item), question context menu, question prompt, and the response area. |
| H   | Jumps to the next heading on the page.  
In general, the following test components are defined with a heading:  
  • Test name (H1)  
  • Student name (H2)  
  • Passage title (H3)  
  • Question number (H3)  
On test pages that have multiple questions, students can jump directly from one question to the next. To do so, press H and then press the Down arrow twice. The question stem is read aloud. |
| Shift + R | Jumps to the previous heading on the page. |
| Tab   | Moves to the next component on the page. In general, the following test elements are components:  
  • Navigation and tool buttons  
  • Question number (and associated prompt text)  
  • Context menu  
  • Response options |
<p>| Shift + Tab | Moves to the previous component on the page |
| Enter | Selects a button or response option or open a context menu. |
| Down Arrow | Moves to the next line on the page |</p>
<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up Arrow</td>
<td>Moves to the previous line on the page</td>
</tr>
<tr>
<td>Insert + Down Arrow</td>
<td>Reads everything on the page (from the current point of focus)</td>
</tr>
<tr>
<td>Ctrl or Space</td>
<td>Stops JAWS from reading</td>
</tr>
</tbody>
</table>

### Opening and Using Context Menus with JAWS Keyboard Commands

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter</td>
<td>Pressing <strong>Enter</strong> when JAWS reads “Menu button” will open the context menu. This is the only way to open the context menu when streamlined mode is turned on.</td>
</tr>
<tr>
<td>Down Arrow</td>
<td>Moves the focus to the next option in the menu. JAWS will read this option aloud.</td>
</tr>
<tr>
<td>Up Arrow</td>
<td>Moves the focus to the previous option in the menu. JAWS will read this option aloud.</td>
</tr>
<tr>
<td>Space</td>
<td>Selects the menu option currently in focus</td>
</tr>
<tr>
<td>Esc</td>
<td>Closes the context menu without selecting any options</td>
</tr>
</tbody>
</table>

### Responding to Items with JAWS Keyboard Commands

<table>
<thead>
<tr>
<th>Tab</th>
<th>Students can use the <strong>Tab</strong> key to navigate to the item prompt, which JAWS will read aloud.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>After JAWS reads the prompt aloud, students can press <strong>Tab</strong> again to navigate to the response area. They may need to press <strong>Tab</strong> multiple times depending on the item type and whether any question labels appear for the item.</td>
</tr>
<tr>
<td></td>
<td>In the response area for an item, students can press <strong>Tab</strong> to navigate between each answer option, text box, selectable text field, keypad button, or check box, depending on the item type.</td>
</tr>
<tr>
<td>Shift + Tab</td>
<td>Navigates to the previous answer option, text box, selectable text field, keypad button, or check box, depending on the item type.</td>
</tr>
</tbody>
</table>

| Up and Down Arrow Keys | For multiple choice and multi-select items, pressing the arrow keys will move between each answer option.                                         |
|                       | For edit task choice items, pressing the arrow keys will move between each line of text in the item. After users open an edit menu by pressing **Space**, the arrow keys can be used to move between the answer options in the drop-down list. |
## Screen Reader Assistive Technology

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Space</strong></td>
<td>• For multiple choice and multi-select items, pressing <strong>Space</strong> will select the answer option in focus.</td>
</tr>
<tr>
<td></td>
<td>• For edit task items, pressing <strong>Space</strong> will open the edit menu in which students type or select a response.</td>
</tr>
<tr>
<td></td>
<td>• For table match items, pressing <strong>Space</strong> will mark the checkbox in focus.</td>
</tr>
<tr>
<td><strong>Enter</strong></td>
<td>• For hot text items, pressing <strong>Enter</strong> will choose the selectable text area in focus as the answer option.</td>
</tr>
<tr>
<td></td>
<td>• For edit task choice items, pressing <strong>Enter</strong> will select an answer option from the drop-down list in the edit menu.</td>
</tr>
<tr>
<td></td>
<td>• For equation items, pressing <strong>Enter</strong> will select the keypad button in focus.</td>
</tr>
<tr>
<td><strong>Alt + 7</strong></td>
<td>• For equation items, pressing <strong>Alt + 7</strong> will open a popup menu with special characters. Students can use the arrow keys to move between the special characters in the list and then press <strong>Enter</strong> to insert a special character in the response area.</td>
</tr>
</tbody>
</table>
Appendix

Practice Test Site Student Sign-in Process

The Student Practice Site allows students to take practice tests. Aside from the sign-in process, the Practice Test Site has the same appearance and functionality as the Student Testing Site.

Students can take practice tests in proctored sessions created in the TA Practice Site or in non-proctored/guest sessions. Students also have the option to sign in to the test sessions with their real identities to take tests specific to their grades or sign in as guests to take tests for any grade-level.

1. To access the Student Practice Site, do one of the following:
   - From the Ohio Assessment Portal (http://ohiostatetests.org), select the Practice Test card.
   - In the Secure Browser, select the Take a Practice Test button.

2. To sign in, students do the following:
   - To sign in as a guest, students set the Guest User toggle to On. Otherwise, to use their real credentials, students set the Guest User toggle to Off and then enter their first name and SSID.
   - To join a guest session, students set the Guest Session toggle to On. Or else, to join a proctored session, students set the Guest Session toggle to Off and enter the Session ID from the TA Practice Site.
   - Students select Sign In.

   - If signed in with their real identities, the Is This You page appears. Students verify their information and click Yes to proceed to the Your Tests page.
   - If signed in as guest users, students are directly taken to the Your Tests page.
3. On the **Your Tests** page, students do one of the following:

   – If signed in with their real identities, students select a test from the ones available for their grade.

   – Students signed in as guests select their grade level from the drop-down list to view the tests available for that grade and then select a test.

4. If the students signed in to a guest session, they must select the test settings they wish to use from the **Choose Settings** page and then select the **Select** button. When selecting the color of the text and background, mouse-pointer, and print size settings, students can see a live preview of their selected settings.

5. If the test includes audio content or text-to-speech settings, the **Audio/Video Checks** page appears displaying the functionality checks that need to be performed. Students must follow the instructions on this page to ensure their device is working properly.
6. On the final sign-in page, students may review the help guide, their test settings, and the additional test information, then select **Begin Test Now** to start or resume their test opportunity.

### U

**User Support and Troubleshooting Information**

**User Support**

For information and assistance in using the Test Delivery System, contact the Ohio Help Desk. The Help Desk is open Monday–Friday 7:00 a.m. to 5:00 p.m. (except holidays or as otherwise indicated on the Ohio Assessment portal).

**Ohio Help Desk**

Toll-Free Phone Support: 877-231-7809

Email Support: OHHelpdesk@air.org

Please provide the Help Desk with a detailed description of your problem, as well as the following:

Test Administrator name

If the issue pertains to a student, provide the student’s SSID and associated district or school. Do not provide the student’s name.

If the issue pertains to a TIDE user, provide the user’s full name and email address.

Any error messages and codes that appeared, if applicable.